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    ¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯
To print the full screen press the Print Scrn Key.
To print the selected active window press Alt + Print Scrn.
To print a specific portion of the screen click the Select Area button.
To print full screen DOS sessions check <Enable Dos Print>.
To print a negative image check <Invert Colors>.
To enlarge the image to full page check <Stretch to Full Page>.

Click on each of the topics below for a more complete description.

      Enable Print Screen
      Enable Dos Print
      Save Image File
      Invert Colors
      Stretch to Full Page

      Select Area
      Save Settings 
      Printer Setup

      Enable
      Disable

      Files <Menu>
      Minimize <Menu>
      Help <This Help File>

      The One Shot Option

      Printing to a Fax Driver

      Network requirements
      Technical Support
      Registration / Ordering Printscreen 95
      Site Licenses

      License Agreement
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Printscreen 95 License Agreement
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯
      Printscreen 95 (Hereafter referred to as the Software) is a Copyrighted 
      product of Glen C. Johnson, dBA Super Simple Software in the State of 
      California. This version is distributed via electronic media as a 
      Shareware product, and in this form, may be distributed without 
      restriction for the purpose of evaluating the Software prior to purchase.
      The Shareware version is compiled with a 50 session limitation. Following 
      registration of the Software and payment of the $19.95 registration fee, the 
      user is provided a registration number which removes the shareware 
      50 session limitation, and upon request, a diskette copy which does not 
      contain the shareware limitation. It is a violation of U.S. Copyright Law and 
      intellectual property rights to provide this registration number to any other 
      person(s) without the author's permission; or to copy or distribute electronically
      the licensed diskette software.    As a registered user you may:

    • use the Software on any single computer;
    • use the Software on a network, provided that each
        person accessing the Software through the network
        is licensed for its use; 
    • use the Software on a second computer owned or
        operated by the licensed user;
    • copy the Software for archival purposes, provided any
        copy must contain all of the original Software's
        copyright notices.

        You may not:

    • modify, translate, reverse engineer, decompile,
        disassemble (except to the extent applicable laws 
        specifically prohibit such restriction), or create 
        derivative works based on the Software;
    • copy the Software other than as specified above;
    • resell the Software for profit without the author's
        permission;
    • remove any proprietary    notices or labels on the
        Software.

    Title, ownership rights, and intellectual property 
    rights of the Software shall remain with Super Simple 
    Software. The Software is protected by United States
    and international copyright laws and treaties. 
    __________________________________________________

    The GIF™ and TIFF™ image compression used in this program
    is licensed under U.S. Patent No. 4,588,302 and foriegn counterparts. 
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Network requirements
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯
 • NETWORK USERS •    A "Printer Error" message can occur in Network applications 
 if the Network Printer Name includes space characters. Example - "HP Laserjet 4si"
 must have the spaces removed, and the printer renamed to "HPLaserjet4si" to avoid
 the problem. This is a "bug" with Visual Basic printer applications which is 
 documented in the Microsoft Knowledge Base. Another symptom of this problem has 
 been reported in which the error message does not occur, but the printout fails to be
 generated.
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Technical Support
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯

 Telephone     Technical Support    is available for Printscreen 95 Mon. - Fri., 8:00 am to 5:00 pm
Pacific Standard Time.      

 

 Tech Support Phone: (310) 839 9543

 24 hr Tech Support Fax: (310) 839 9280

 Technical Support E-Mail: glencj@sssware.com
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                      Printscreen 95 Order Form
                                                                                      (Click the Print button above to print this form.)
 PLEASE TELL US WHERE YOU RECEIVED YOUR COPY OF PRINTSCREEN    95?
 ONLINE SERVICE.............INTERNET..............BBS?..........MAGAZINE?...............

 YOUR NAME......................................................................................................

 COMPANY.........................................................................................................

 ADDRESS .........................................................................................................

 CITY..........................................................................STATE...............................

 COUNTRY.........................................ZIP \ POSTAL CODE...................................

 PHONE..........................................................FAX...............................................

 E-MAIL ADDRESS...............................................................................................
 __________________________________________________________________
 • CREDIT CARD ORDERS •    Visa, MasterCard, American Express    accepted.

 Credit Card type & number____________________________________________

 Expiration Date_____________________________________________________

 • To place a credit card order via telephone dial (310) 839 9543 • 8am-5pm pacific •
 • 24 Hour Order Fax Line: (310) 839 9280 • Corporate Purchase Orders accepted.

 PRICING AND SITE LICENSE INFORMATION:    

 1 - 9 $19.95        Per Copy / User
 10 - 24 $15.00 "
 25 - 49 $9.00 "
 50 - 99 $7.00 "
 100 - 199 $5.00 "
 200    - 1000 ..................... $ 995.00    (Flat fee) 
                (Site license for quantities above 1000 users = $1.00 per user.) 
 NUMBER OF COPIES OF PRINTSCREEN    95 ______________    @    _________.

TOTAL    = $_______________.
 Select Delivery Method:
 Registration Code via fax or E-Mail [    ]
 3½" diskette via regular mail [    ]

 PLEASE    MAKE CHECK    OR MONEY ORDER PAYABLE TO:

 Glen Johnson
 2817 So. La Cienega Ave #B     You can also register via CompuServe
 Los Angeles, CA    90034     at keyword GO SWREG. Use file ID #7206
  
                        (C) 1996-1997 Super Simple Software 



Disable
¯¯¯¯¯¯¯
 The Enable button is used along with the Disable button to activate or deactivate the Printing
 and Save Image features using all three selection methods:    Print Scrn, Alt + Print Scrn and 
 Select Area. This feature is provided in order to allow you to copy the screen or active window
 to the Windows Clipboard and make the image available to paste into another application
 such as MS Word, PowerPoint or an image editing program. When Printscreen 95 is 
 re-activated using the Enable button, the screen or active window images will then be sent to
 the printer instead of remaining on the clipboard. 

 • Note • The One Shot option is a separate program which is installed with the Printscreen 95 
 setup application. A separate shortcut is created which can be executed to print the full screen
 without acquiring the image from the Windows clipboard. After printing the screen the One
 Shot program automatically terminates. This mode can be used instead of leaving the main
 Printscreen 95 program running in the background. 
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Stretch to Full Page
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯
 The Stretch to Full Page option will enlarge the captured image to fill the full page 
 width and height. The aspect ratio of the original image is not maintained, however. 
 In order to maintain the approximate aspect ratio, a screen, window or selected 
 region that is wider than it is tall should be printed in Landscape Mode. An image 
 that is taller than it is wide should be printed in Portrait. 
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Select Area
¯¯¯¯¯¯¯¯¯¯¯
 The Select Area feature allows you to draw a rectangle on the screen using the mousepointer, 
 and print or save the area within the rectangle. The procedure requires 2 clicks of the Select 
 Area button to operate. The first click will cause the main Printscreen 95 window to minimize, 
 and the Select Area button will re-display in the lower right-hand corner of the screen and 
 begin flashing. Click the button again to initiate the capture mode. After a few seconds the 
 mousepointer will change to a "+" and the "Capture ready..." message will appear at the 
 bottom of the screen. Position the mousepointer in the upper left corner of the area you wish
 to capture. Press and hold the left mousebutton and drag the mousepointer down and to the
 right. A dotted rectangle will be drawn. When the rectangle covers the desired area, release
 the mousebutton. The area selected will immediately be printed and/or captured, depending on 
 the options selected on the main Printscreen 95 Window. 

 • Note • After you begin to draw the capture rectangle, the procedure cannot be aborted or
 re-initiated if you discover you've slightly "missed" the desired capture area. Simply click the 
 Select Area button and try again. (Also, if the mousepointer is not moved between the 
 Mouse_Down and Mouse_Up events, a zero size area capture will produce an error, and you
 will have to restart the program.) 
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Save Settings
¯¯¯¯¯¯¯¯¯¯¯¯
 The Save Settings button is used to save the options selections from the Main Printscreen
 95 window into the prtscr95.ini file. Included are the selections available in the Configure 
 User Options Menu. When the OK button is selected to save the Configure User Options
 values, all settings in the prtscr95.ini file are re-saved. It is not necessary to also click the
 Save Settings button.
 

 • Note • The Enable and Disable radio button values are not saved in the .ini file. 
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Printer Setup
¯¯¯¯¯¯¯¯¯¯¯¯¯
 The Printer Setup button displays the Windows Printer Setup Dialog which provides the user
 selections for the printer to receive the Printscreen 95 output and printer setup features such
 as orientation (portrait or landscape), and paper size, as well as advanced device options 
 specific to the printer being used. The Printer Setup Dialog is shown below. Select the Options 
 button to access the advanced device options mentioned above. These include port selection, 
 printer memory and Network options.

             

 • Note • The Visual Basic Printer object outputs to the default Windows printer. The 
 selections made for printer type (driver) and other options are saved as the Windows 
 defaults.         
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Enable Print Screen
 ¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯
  
 Check Enable Print Screen to activate the full screen and selected active window
 print modes using the Print Scrn Key and Alt + Print Scrn methods. This option must 
 also be selected in order to use the Select Area feature to print specific portions of 
 the screen. 

 • Note • Image files may be saved from screen capures by checking the Save Image File option, 
 regardless of whether Enable Print Screen is selected. The two modes operate completely 
 independent of one another.

Help file generated by VB HelpWriter.



Enable
¯¯¯¯¯¯¯
 The Enable button is used along with the Disable button to activate or deactivate the Printing
 and Save Image features using all three selection methods:    Print Scrn, Alt + Print Scrn and 
 Select Area. This feature is provided in order to allow you to copy the screen or active window
 to the Windows Clipboard and make the image available to paste into another application
 such as MS Word, PowerPoint or an image editing program. When Printscreen 95 is 
 re-activated using the Enable button, the screen or active window images will then be sent to
 the printer instead of remaining on the clipboard. 

 • Note • The One Shot option is a separate program which is installed with the Printscreen 95 
 setup application. A separate shortcut is created which can be executed to print the full screen
 without acquiring the image from the Windows clipboard. After printing the screen the One
 Shot program automatically terminates. This mode can be used instead of leaving the main
 Printscreen 95 program running in the background. 
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Invert Colors
¯¯¯¯¯¯¯¯¯¯¯¯

 The Invert Colors option produces a negative print image, which helps to save 
 toner when printing windowed "DOS Boxes", or other screens with dark backgrounds 
 and light text. The Invert Colors option is only available for printed images, and has no 
 effect on saved image files.
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Save Image File
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯
 Check Save Image File to save the captured screen, window or selected region to an
 image file using one of the following formats:

Windows BMP (True Color)
Windows BMP (256 Color)
Compressed BMP (256 Color)
Compressed 16 Color BMP
GIF (256 Color)
GIF (256 Color Greyscale)
GIF (Greyscale 16 Color)
JPEG (True Color)
PCX (True Color)
TIFF (True Color)

 The image generated using the Print Scrn Key, Alt + Print Scrn or Select Area method
 will be re-displayed in the Save Image window. From the Files Menu at the top of the screen,
 select Save As... to save the image to one of the file formats listed above. The figure below 
 shows the Save Image window with the Files Menu open to display the available formats.
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Enable Dos Print
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯
 Check Enable Dos Print to print full screen Dos sessions using the Print Scrn key. Many 
 DOS based programs use ANSI line draw characters to form lines and boxes on the screen.
 The Windows printer and display character sets do not recognize ANSI line draw characters, 
 and will substitute + and - sign characters. Any informational text data should print correctly.

 The Dos Print Mode is a text-only function, and does not support DOS graphics. You can 
 print graphic screens in DOS applications by pressing Alt + Enter to change the Dos prompt
 to a Windowed "DOS Box". The Dos prompt then becomes the active window, and will print in
 graphic mode using Alt + Print Scrn. In Windows 95 the DOS Window can be maximized to
 fill approximately 80% of the screen. In this mode the screen image is compressed vertically
 about 20%, which changes the aspect ratio slightly, but the screen information should still be
 legible in the final printout. Windows 3.1 will only display the DOS Window at about 50% of the
 full screen size. The print resolution in this situation can be improved by selecting Stretch to
 Full Page, and printing the screens in Landscape Mode. 
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Files
¯¯¯¯¯
      The Files Menu contains the following 2 submenus:

            Work with Image Files
            Configure User Options
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Minimize
¯¯¯¯¯¯¯¯¯
      Select the Minimize menu option to minimize the Main Printscreen 95 Window.
      This option was changed to a menu selection after confusion was expressed by
      Windows 95 and Windows 3.1 users concerning the fact that the standard 
      "minimize" button at the upper right corner of the window is different in each 
      operating system. 
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Printscreen 95 - Image Files
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯
      The Work with Image Files menu selection displays the Printscreen 95 Image 
      Files Window. The Image Files Window can be used as a graphic file viewer and
      convertor to open, view and save image files in the following formats:

Windows BMP (True Color)
Windows BMP (256 Color)
Compressed BMP (256 Color)
Compressed 16 Color BMP
GIF (256 Color)
GIF (256 Color Greyscale)
GIF (Greyscale 16 Color)
JPEG (True Color)
PCX (True Color)
TIFF (True Color) 

                                                                                                              

      The Image File Window menu selections are shown in the figure above. Typical options
      are selectable to open, save and print image files. The Edit Menu allows you to Copy 
      and Paste images to and from the Windows Clipboard. Select Convert to Greyscale to 
      convert the image currently displayed to 256 Shade - 8 bit greyscale. (Black & White.)

      • The Advanced Print Options • 

      An image displayed in the Image Files Window can be printed using a higher level of
      printing code by selecting the Print option from the File Menu. The Advanced Print Dialog 
      shown below is displayed before the print operation is initiated. Options are available to
      position the image on the page, select the Printer Halftone mode (pattern format) and 
      center the image on the page, if desired. This print mode must be selected in order to 
      use a FAX Printer driver if you want to send an image as a fax output. The standard print
      modes using the Enable Print Screen selection are not fax-compatible. Check the Save 
      Image File option instead of Enable Print Screen. When the screen re-displays in the 
      Save Image Window, select Print from the File menu.
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User Options
¯¯¯¯¯¯¯¯¯¯¯¯

                                              

      The Configure User Options screen contains the following selections: 

          Select information to print at the top of the page
               User Name
                System Date and Time

          Always show Select Area Button 
          Save DOS screens to appended .txt file. 
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Always show Select Area Button
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯
      This option is provided to make the Select Area feature easier to access when used 
      frequently. The Select Area button will remain displayed in the lower right hand
      corner of the screen where it can be easily operated without having to re-display the
      main Printscreen 95 window. (With the Select Area button already displayed, only a
      single click is required to initiate the capture mode.)          
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Save DOS screens to appended .txt file.
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯
      This option is provided to save DOS screens to an appended text file instead of printing.
      Successive Print Scrn key operations in full screen DOS prompts will be written to the
      default .txt (Log) file named <dosapp.txt>, in the current directory. If a different filename is
      desired, you can specify any name you choose. 
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User Options, User Name
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯
      Use this option to print the User's Name or other specified information at the top of each 
      page. Up to 80 characters can be entered in the field below the User Name checkbox.

      • Note • Click the OK botton to save the selections in the Configure User Options screen 
      into the prtscr95.ini file. It is not necessary to re-select Save Settings for these options.
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User Options, System Date and Time
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯
      Select this option to print System Date and Time at the top of each printed page.
      This feature is supported in both the Windows and DOS print modes. 
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The One Shot Option
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯
 The One Shot option is a separate program which is installed with the Printscreen 95 setup 
 application. A separate shortcut is created which can be executed to print the full screen
 without acquiring the image from the Windows clipboard. (Printscreen 95 acquires images to 
 print or save from the Windows clipboard. If you want to copy a screen or active window to
 the clipboard and make it available to paste into another application, such as MS Word or
 PowerPoint, etc..., you can either click the DISABLE button, or use the One Shot mode for
 screen prints instead of running the main Printscreen 95 program in the background.)

 After printing the screen the One Shot program automatically terminates. No active memory
 resident program is left running.

            If the One Shot mode is to be used frequently, you can set up a 
            short cut key such as CTRL + ALT + P using the following steps:

            • RIGHT CLICK the Start button
            • Select OPEN
            • DOUBLE CLICK Programs
            • DOUBLE CLICK the Printscreen 95 Folder
            • RIGHT CLICK the One Shot Icon
            • Select PROPERTIES
            • Select the Shortcut Tab
            • Place the cursor in the Short Cut Key field
            • Press "P" to set Ctrl-Alt-P as the shortcut key sequence, (example) Any letter
                        can be used.

            You can then print the full screen using the Shortcut Key Sequence at any time,
            and use the Print and Alt-Print key sequences to copy screen images to the 
            clipboard.
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